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BAB III 

METODE PENELITIAN 

 

Proses pelaksanaan penelitian ini terlihat manakala adanya suatu metode 

penelitian. Cara-cara yang rasional, empiris, dan sistematis yang mendasari dalam 

penentuan metode penelitian. Penelitian ini terdiri dari beberapa variabel. Variabel 

bebas yang dimanipulasi dalam penelitian ini adalah Sport Education (SE) dan 

Emotional Intelengence (EI) sebagai varibel moderator. Sedangkan variabel 

dependen di dalam penelitian ini menggunakan keterampilan bermain bolabasket. 

Metode penelitian yang digunakan dalam penelitian ini adalah metode eksperimen, 

sebuah metode penelitian yang mengungkap keterkaitan sebab akibat antar variabel 

yang dapat dimanipulasi variabel independen (Fraenkel et al., 2013, hlm. 265).  

3.1. Desain Penelitian 

Desain penelitian yang digunakan dalam penelitian ini menggunakan desain 

faktorial. Berdasarkan kepada kebutuhan penelitian yang memaparkan bahwa untuk 

pencapaian hasil keterampilan bermain sampel akan ada EI yang mengiringi. Maka, 

dalam penelitian ini juga ingin mengkaji interaksi antara SE dan EI sehingga desain 

dikembangkan menggunakan faktorial 2x2.  

Desain ini merupakan modifikasi dari desain kelompok kontrol pretest-

posttest. Ini melibatkan satu perlakuan dan satu kelompok kontrol, dan variabel 

moderator memiliki dua level. Dua kelompok akan menerima perlakuan dan dua 

kelompok tidak akan. Karena setiap variabel atau faktor memiliki dua level, maka 

desain disebut desain faktorial 2x2 (Fraenkel et al., 2013, hlm. 279). Gambar desain 

penelitian akan digambarkan sebagai berikut:  

 

Sport Education 

 

Emotional  

Intelligence 

Hybrid SE-IGCM 

A1 

SEM 

A2 

Tinggi B1 A1B1 A2B1 

Rendah B2 A1B2 A2B2 

 

Gambar 3.1. 

Desain Faktorial 2x2 
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Keterangan: 

A1 

A2 

B1 

B2 

A1B1 

A2B1 

A1B2 

A2B2 

= 

= 

= 

= 

= 

= 

= 

= 

Sport Education Hybrid SE-IGCM 

Sport Education 

Emotional Intelligence tinggi 

Emotional Intelligence rendah 

Sport Education Hybrid SE-IGCM Emotional Intelligence tinggi 

Sport Education Hybrid SE-IGCM Emotional Intelligence rendah 

Sport Education Emotional Intelligence tinggi 

Sport Education Emotional Intelligence rendah 

 

3.1.1 Definisi Operasional Variabel 

Definisi operasional variabel merupakan aspek penelitian yang memberikan 

informasi bagaimana cara mengukur variabel-variabel yang digunakan dalam 

sebuah penelitian antara lain: 

1) Variabel Independen/ Bebas 

Variabel bebas adalah merupakan variabel yang dipilih peneliti yang 

mempengaruhi sebab perubahannya satu varibel atau lebih (Fraenkel et al., 2013, 

hlm. 80). Dalam penelitian ini yang menjadi varibel bebas adalah SE yang terdiri 

dari Hybrid SE-IGCM cabang olahraga bolabasket dan SE cabang olahraga 

bolabasket. 

2) Variabel Dependen/ Terikat 

Variabel terikat merupakan variabel yang dipengaruhi oleh variabel 

independen atau yang menjadi akibat, karena adanya variabel independen (Fraenkel 

et al., 2013, hlm. 80). Dalam penelitian ini terdapat satu varibel terikat yaitu 

keterampilan bermain. 

3) Variabel Moderator 

Variabel Moderator adalah variabel yang mempengaruhi (memperkuat dan 

memperlemah) hubungan antara variabel independen dengan dependen (Fraenkel 

et al., 2013, hlm. 81). Variabel disebut juga sebagai variabel independen kedua. 

Dalam penelitian ini yang menjadi variabel moderator adalah EI. EI setiap sampel 

berbeda sehingga EI dibagi ke dalam dua kategori yaitu: sampel dengan EI tinggi 

dan siswa dengan EI rendah. 

3.1.1.1 Definisi Operasional Variabel Sport Education 

Penelitian ini menggunakan Hybrid SE-IGCM yang merupakan gabungan 

dari SE dan IGCM. Fitur struktural seperti peran setiap siswa didapat dari SE, 
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dengan menggunakan tiga tahap dengan 5 pertemuan setiap tahapnya dengan total 

15 pertemuan (Perlman, 2012a), yang diadaptasi oleh hasil karya (Ginanjar, 2019b) 

dengan interrater reliability 0.94 pada perencanaan dan 0.73 pada implementasi. 

Untuk tugas pembelajaran dengan menggunakan kerangka didaktik pada IGCM 

(Mesquita et al., 2012).  

Pada tahap skill/tactical development di SE lebih menekankan kepada 

kemampuan keterampilan gerak olahraga yang akan digunakan (Ginanjar, 2019b, 

2019a; Ginanjar & Suherman, 2018) yang dimodifikasi dengan menggunakan 

BGFs di IGCM yang merupakan versi modifikasi dari permainan formal yang 

bertujuan untuk memfasilitasi tanggapan pemain terhadap masalah tertentu yang 

terkait dengan struktur permainan invasi (Mesquita et al., 2012). Pada tahap 

inter/intra team games with practices di SE menekankan kepada kompetisi di dalam 

tim untuk menghadapai pertandingan antar tim pada tahap selanjutnya (Ginanjar, 

2019b, 2019a; Ginanjar & Suherman, 2018), yang dimodifikasi dengan 

menggunakan PGFs di IGCM dirancang untuk memecahkan masalah strategis yang 

spesifik dengan memaksakan kondisi, perubahan aturan, dan modifikasi peralatan 

pada permainan (Mesquita et al., 2012). Pada tahap postseason di SE yang 

merupakan merupakan refleksi dari tahapan-tahapan sebelumnya dengan adanya 

kompetisi (Ginanjar dkk., 2019), yang dimodifikasi dengan menggunakan GLTs di 

IGCM untuk memperkenalkan dan meningkatkan aspek keterampilan khusus 

tertentu, menjaga tuntutan situasional PGFs dengan cara ini kinerja keterampilan 

permainan ditingkatkan tetapi terintegrasi dengan komponen lain dari permainan 

(Mesquita et al., 2012). Untuk lebih jelas dalam treatment dapat di lihat pada tabel 

di bawah ini.  

Tabel 3.1. 

Program Hybrid SE-IGCM 

Tahapan Musim 
Pertemuan 

ke 
Komponen Hybrid SE-IGCM 

Skill/ tactical 

development 

1  Pengantar bolabasket 

 Membutuhkan penilaian 

 Identifikasi pelatih tim 

 Seleksi tim dan nama tim 

 Aturan peran siswa 
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 GLTs (2vs2) semua tim terlibat Tim A, 

Tim B, Tim C (Pretest menggunakan 

tata cara BOGPI) 

2  Latihan tim 

BGFs setiap tim dengan tim masing-

masing (1vs1) 1 offence dan 1 defence 

permainan hanya menggunakan passing 

dengan sasaran menembak ke arah tiang 

yang telah disediakan  

3  Latihan tim 

BGFs setiap tim dengan tim masing-

masing (1vs1) 1 offence dan 1 defence 

permainan hanya menggunakan passing 

dan dribbling dengan sasaran 

menembak ke arah tiang yang telah 

disediakan  

4  Latihan tim 

BGFs setiap tim dengan tim masing-

masing (1vs1) 1 offence dan 1 defence 

permainan full 

5  Latihan tim 

BGFs setiap tim dengan tim masing-

masing (1vs1) 1 offence dan 1 defence 

permainan full 

Inter/intra team 

games with practices 

6  Musim reguler 

PGFs setiap siswa dalam setiap tim 

saling bertanding (1vs1) menang poin 1 

dan kalah poin 0 dengan permainan full 

7  Musim reguler 

PGFs setiap siswa dalam setiap tim 

saling bertanding (1vs1) menang poin 1 

dan kalah poin 0 dengan permainan full 

8  Musim reguler 

PGFs setiap siswa dalam setiap tim 

saling bertanding (1vs1) menang poin 1 

dan kalah poin 0 dengan permainan full 

9  Musim reguler 

PGFs setiap siswa dalam setiap tim 

saling bertanding (1vs1) menang poin 1 

dan kalah poin 0 dengan permainan full 

10  Musim reguler 

PGFs setiap siswa dalam setiap tim 

saling bertanding (1vs1) menang poin 1 

dan kalah poin 0 dengan permainan full 

Postseason 11  Latihan tim (tim yang tidak bertanding) 
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 Turnamen akhir musim GLTs (2vs2) 

Tim A vs Tim B (babak penyisihan  

menang poin 1 dan kalah poin 0) 

12  Latihan tim (tim yang tidak bertanding) 

 Turnamen akhir musim GLTs (2vs2) 

Tim A vs Tim C (babak penyisihan  

menang poin 1 dan kalah poin 0) 

13  Latihan tim (tim yang tidak bertanding) 

 Turnamen akhir musim GLTs (2vs2) 

Tim B vs Tim C (babak penyisihan  

menang poin 1 dan kalah poin 0) 

14  Poin Ganda (menang poin 2 kalah poin 

0) 

 GLTs (2vs2) semua tim terlibat Tim A, 

Tim B, Tim C (Posttest menggunakan 

tata cara BOGPI)  

15  Final (Peringkat 1 vs Peringkat 2). GLTs 

(2vs2) 

 Perayaan penghargaan  

 

Sedangkan untuk program SE adalah sebagai berikut: 

 

Tabel 3.2. 

Program Sport Education 

Tahapan Musim Pertemuan ke 
Komponen 

Sport Education 

Skill/ tactical 

development 

1  Pengantar bolabasket 

 Membutuhkan penilaian 

 Identifikasi pelatih tim 

 Seleksi tim dan nama tim 

 Aturan peran siswa 

2  Latihan tim 

 Passing 

3  Latihan tim 

 Dribbling 

4  Latihan tim 

 Shooting 

5  Latihan tim 

 Offence atau defence 

Inter/intra team games 

with practices 

6  Latihan tim 

 Musim reguler (1vs1) 

7  Latihan tim 
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 Musim reguler (1vs1) 

8  Latihan tim 

 Musim reguler (1vs1) 

9  Latihan tim 

 Musim reguler (1vs1) 

10  Latihan tim 

 Musim reguler (1vs1) 

Postseason 11  Latihan tim (tim yang tidak 

bertanding) 

 Turnamen akhir musim  

12  Latihan tim (tim yang tidak 

bertanding) 

 Turnamen akhir musin 

13  Turnamen akhir musin 

14  Turnamen akhir musin 

15  Final (Peringkat 1 vs Peringkat 2) 

 Perayaan penghargaan 

 

Berdasar program ]di atas baik Hybrid SE-IGCM dan SE murni, untuk lebih 

lengkap tentang skenario musim pembelajaran dapat dilihat pada lampiran 1 dan 

lampiran 2. Berikut salah satu contoh skenario pembelajaran yang digunakan pada 

Hybrid SE-IGCM dan SE: 

Tabel 3.3. 

Skenario Pembelajaran Pertemuan 2 (Hybrid SE-IGCM) 

Musim Olahraga : Bolabasket 

Tujuan  : Siswa dapat mengaplikasikan, menampilkan, dan 

menintegrasikan sesuai peran di dalam timnya. 

Waktu  : 2 x 45 menit 

Sarana Prasarana : Lapangan bola basket, bola basket, peluit, stopwatch, 

buku catatan, dan infokus. 

Kegiatan 

Pembelajaran 
Deskripsi Kegiatan Waktu 

A Pendahuluan  

Berdoa  Berdoa  
15 menit 

Mengabsen  Absen  
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Pemberian 

awareness 

 Guru mengingatkan tentang tanggung 

jawab dan menghormati tugas yang 

didapat siswa dalam setiap perannya 

 Guru menjelaskan contoh implikasi 

tanggung jawab dan menghormati 

tugas yang didapat siswa dalam setiap 

perannya 

Penyampaian 

tujuan 

pembelajaran 

Menjelaskan peraturan, prosedur, 

keterampilan, dan strategi untuk latihan 

passing 

Manager tim mempersiapkan 

perlengkapan yang akan digunakan 

Pemanasan  Peregangan statis dan dinamis 10 menit 

B Kegiatan Inti 

Tugas gerak 

Setiap kelompok berlatih dengan 

kelompoknya untuk berlatih passing 15 menit 

Melakukan program BGFs setiap tim 

dengan tim masing-masing 1vs1, 1 offence 

dan 1 defence permainan hanya 

menggunakan passing dengan sasaran 

menembak ke arah tiang yang telah 

disediakan 

40 menit 

C Penutup 

Pendinginan  Peregangan statis dan dinamis 

10 menit Riview hasil 
 Tanya jawab 

 Motivasi 

Berdoa  Berdoa  

Total Waktu 90 Menit 

 

Sedangkan skenario untuk SE adalah sebagai berikut: 

Tabel 3.4. 

Skenario Pembelajaran Pertemuan 2 (Sport Education Bolabasket Pembelajaran 

Passing dengan Menggunakan Model Pembelajaran Direct Intruction) 

Musim Olahraga : Bolabasket 

Tujuan  : Siswa dapat mengaplikasikan, menampilkan, dan 

menintegrasikan sesuai peran di dalam timnya. 

Waktu  : 2 x 45 menit 

Sarana Prasarana : Lapangan bola basket, bola basket, peluit, stopwatch, 

buku catatan, dan infokus. 
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Kegiatan 

Pembelajaran 
Deskripsi Kegiatan Waktu 

A Pendahuluan  

Berdoa  Berdoa  

15 menit 

Mengabsen  Absen  

Pemberian 

awareness 

 Guru mengingatkan tentang tanggung 

jawab dan menghormati tugas yang 

didapat siswa dalam setiap perannya 

 Guru menjelaskan contoh implikasi 

tanggung jawab dan menghormati tugas 

yang didapat siswa dalam setiap perannya 

Penyampaian 

tujuan 

pembelajaran 

Menjelaskan peraturan, prosedur, 

keterampilan, dan strategi untuk latihan 

passing dan bentuk tes yang digunakan 

Manager tim mempersiapkan perlengkapan 

yang akan digunakan 

Pemanasan  Peregangan statis dan dinamis 10 menit 

B Kegiatan Inti 

Tugas gerak 

Setiap kelompok berlatih dengan 

kelompoknya untuk berlatih passing di 

pimpin oleh pelatih yang dibantu oleh kapten 
10 menit 

Melakukan tes passing menggunakan tes 

nurhasan passing. 10 menit 

Latihan lanjutan. Setiap kelompok berlatih 

passing dengan kelompoknya di pimpin oleh 

pelatih yang dibantu oleh kapten dan 

membuat strategi untuk penilaian yang kedua, 

saling mengajari untuk mengurangi waktu 

pada tes yang pertama 

10 menit 

Melakukan tes passing menggunakan tes 

nurhasan dan berusaha untuk bisa melebihi tes 

yang pertama 
10 menit 

 Game (1 vs 1) dengan menggunakan passing 15 menit 

C Penutup 

Pendinginan  Peregangan statis dan dinamis 

10 menit 
Riview hasil 

 Pengumuman hasil tes yang dilakukan 

oleh manager tim 

 Tanya jawab 

 Motivasi 
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Berdoa  Berdoa  

Total Waktu 91 Menit 

 

3.1.1.2 Definisi Operasional Variabel Keterampilan Bermain 

Penelitian tentang keterampilan bermain ini dengan menggunakan 

Basketball Offensive Game Performance Instrument (BOGPI). BOGPI dirancang 

untuk menilai kinerja menyerang dalam permainan bolabasket. Dengan 

menggunakan lembar kerja BOGPI, seorang penilai mengamati dan mencatat ada 

atau tidaknya perilaku permainan yang ditentukan pada setiap komponen subgame 

(Chen et al., 2016).  

3.1.1.3 Definisi Operasional Variabel Emotional Intelligence 

EI pertama  kali  diperkenalkan  oleh  Salovey  dan  Mayer yang merupakan 

kecerdasan dalam memahami perasaan diri sendiri dan perasaan orang lain, dapat 

memotivasi, dan mengelola emosi dalam menjalani kehidupan (Behera, 2016; 

Petrides & Furnham, 2000). Kecerdasan emosional terdiri dari 4 komponen utama 

yaitu emotionality, sociability, self-control, dan well-being. emotionality (Petrides, 

2009). 

3.1.2 Validitas Internal dan Eksternal  

Berkaitan dengan metode eksperimen dengan desain faktorial. Di dalam 

penelitian eksperimen terdapat variabel asing yang tidak terkontrol yang 

mempengaruhi terhadap variabel bebas terhadap validitas dari ekperimen tersebut. 

Validitas dalam penelitian eksperimen terdapat validitas internal dan validitas 

eksternal. Sedangkan validitas eksternal merupakan perubah dari kelompok-

kelompok diluar dari penelitian itu sendiri.  

3.1.2.1 Validitas Internal 

Validitas internal harus diamati terhadap perubahan variabel terikat, 

perubahan tersebut akibat dari variabel bebas yang dimanipulasi. Dalam desain 

faktorial terdapat beberapa validtas internal yang tidak dapat dikontrol, yaitu: 

pengaruh lokasi, pengaruh karakteristik pengumpulan data, pengaruh bias 

pengumpulan data, pengaruh sikap subjek, dan pengaruh implementasi (Fraenkel et 

al., 2013).  

1) Pengaruh Lokasi 
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Usaha yang dilakukan agar tidak terjadi pengaruh lokasi penelitian 

menggunakan alternatif berbagai tempat penelitian. Bila lapangan tidak dapat 

digunakan atau hujan peneliti menggunakan gedung olahraga yang telah tersedia. 

2) Pengaruh Karakteristik Pengumpulan Data 

Usaha yang dilakukan agar tidak terjadi pengaruh karakterisitk 

pengumpulan data penelitian menggunakan instrumen yang sama setiap melakukan 

tes terhadap partisipan penelitian. 

3) Pengaruh Bias Pengumpulan Data 

Usaha yang dilakukan agar tidak terjadi pengaruh bias pengumpulan data 

penelitian menggunakan jumlah tes yang sama dalam melakukan tes. 

4) Pengaruh Sikap Subjek 

Usaha yang dilakukan agar tidak terjadi pengaruh sikap subjek dalam 

penelitian, peneliti mempersiapkan air minum bila subjek merasa haus untuk 

menghindari subjek pergi ke kantin untuk membeli minuman selama proses 

penelitian berlangsung. 

5) Pengaruh Implementasi 

Usaha yang dilakukan agar tidak terjadi pengaruh perlakuan penelitian 

memberikan perlakuan yang sama kepada semua subyek penelitian. 

3.1.2.2 Validitas Eksternal 

1) Validitas Populasi  

Validitas ini bertujuan agar karakteristik sampel dapat mewakili populasi, 

sampel diambil secara random, mengambil sampel siswa dengan tingkat belajarnya 

yang sama, memberikan hak yang sama dalam pemberian perlakuan. 

2) Validitas ekologi  

Dikontrol dengan menggunakan program pembelajaran disusun dan 

dijadwalkan dengan jelas, tidak mengubah jadwal yang telah ditetapkan, 

menggunakan sarana dan prasarana yang cukup memadai, tidak memberitahu 

kepada partisipan bahwa mereka sedang dijadikan subyek penelitian untuk 

menghindari pengaruh reaktif akibat proses penelitian tersebut. 

 

3.2 Partisipan 
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Partisipan penelitian ini adalah siswa kelas X di SMKN 2 Kuningan, 

Kecamatan Kuningan, Kabupaten Kuningan sebanyak 68 orang. Waktu dalam 

penelitian ini adalah kurang lebih selama dua bulan dari September 2018 sampai 

November 2018 dengan frekuensi pertemuan sebanyak 15 kali pertemuan untuk 

treatment baik Hybrid SE-IGCM di kelas eksperimen dan SE di kelas kontrol. 

Tempat penelitian di SMKN 2 Kuningan yang terletak di Jalan Cigugur No. 28 

Kabupaten Kuningan. 

 

3.3 Populasi dan Sampel 

3.3.1 Populasi  

Populasi dalam penelitian ini adalah siswa SMKN 2 Kuningan kelas X yang 

terdiri dari 7 kelas yaitu X A sampai X G. Keseluruhan populasi dari semua kelas 

berjumlah 208 siswa.  

3.3.2 Sampel  

Sampel adalah jumlah kecil dari populasi dimana akan diperoleh informasi 

dari penelitian (Fraenkel et al., 2013, hlm. 91). Kemudian berdasarkan kepada 

kebutuhan penelitian yang akan menggunakan sampel siswa yang memiliki EI 

tinggi dan rendah. Langkah yang diambil dari total populasi sebanyak 208 orang 

yang terlebih dahulu dilakukan tes EI untuk mengetahui siswa yang memiliki EI 

tinggi dan siswa yang memiliki EI rendah dengan menggunakan 27% atas dan 27 

% bawah, sehinga didapat 56 orang pada kelompok atas dan 56 orang pada 

kelompok bawah. Untuk menentukan ukuran sampel dengan menggunakan rumus 

Taro Yamane dengan rumus sebagai berikut: 

n = 
N

N.d²+1
  

Dimana: 

n 

N 

d2
 

= 

= 

= 

Jumlah sampel 

Jumlah populasi 

Presisi yang ditetapkan 

Dari hasil perhitungan ukuran sampel dengan populasi 208 didapat dengan 

tingkat presisi sebesar 10 % didapat jumlah sampel sebesar 68 orang. Dari 68 orang 

sampel yang akan digunakan dibagi dua menjadi 34 orang untuk kelompok atas dan 
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34 orang kelompok bawah yang disesuaikan dengan 27 % atas dan bawah. Sehingga 

dari 68 orang baik di kelompok atas ataupun kelompok bawah di ambil 34 orang 

sebagai sampel dengan menggunakan teknik simple random sampling.  

Sedangkan untuk pembagian kelompok dengan menggunakan random 

assignment. Kedua kelompok dibagi lagi menjadi dua kelompok dengan 

menggunakan random assigment untuk mendapatkan yang akan dipergunakan. 

Kemudian menentukan kelompok A1B1 mendapatkan perlakukan Hybrid SE-

IGCM dengan EI tinggi, kelompok A2B1 mendapatkan perlakuan SEM dengan EI 

tinggi, kelompok A1B2 mendapatkan perlakuan Hybrid SE-IGCM dengan EI 

rendah, dan kelompok A2B2 mendapatkan perlakuan SEM dengan EI rendah, 

sehingga dalam tiap kelompok terdiri dari 17 orang. Untuk lebih jelas dapat dilihat 

pada tabel di bawah ini. 

Tabel 3.5. 

Hasil Pembagian Kelas Penelitian 

Sport Education 

 

Emotional  

Intelligence 

Hybrid SE-IGCM 

A1 

SE 

A2 

Tinggi B1 

2,6,9,11,14,17,18,21 

26,29,31,37,40,43,46 

49,52 

4,8,12,15,19,23,25,28 

32,35,38,41,44,47,50 

53,56 

Rendah B2 

153,154,155,162,166 

167,169,170,173,174 

181,186,187,193,198 

203,208 

163,175,178,179,182 

183,184,189,192,194 

196,197,199,200,202 

204,206 

  

3.4 Instrumen Penelitian 

Instrumen penelitian merupakan alat atau fasilitas yang digunakan oleh 

peneliti dalam mengumpulkan data. Instrumen penelitian sangat berpengaruh 

terhadap keberhasilan suatu penelitian, oleh karena itu penyusunan instrumen 

penelitian harus dirancang dengan baik agar diperoleh hasil sesuai dengan 

kegunaannya. 

 

3.4.1 Emotional Intelligence 
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Untuk mengukur EI menggunakan tes EI yang telah ada hasil penelitian 

(Jonker & Vosloo, 2008). Langkah awal peneliti melakukan validasi terkait dengan 

keterbacaan dan isi kepada dua expert judgment. Satu orang expert judgment 

merupakan ahli bahasa dan satu orang expert judgment merupakan ahli psikologi. 

Berikut bentuk pernyataan yang telah di validasi dapat dilihat pada tabel di bawah 

ini. 

 

 

Tabel 3.6. 

Validasi Instrumen Penelitian EI 

No 
Item Emotional Intelligence 

Scale 
Terjemahan 

1 I know when to speak about my 

personal problems to others 

Saya tahu kapan harus berbicara 

tentang masalah pribadi saya kepada 

teman sekelas 

2 When I am faced with obstacles, 

I remember times I faced 

similiar obstacles and overcame 

them 

Ketika saya dihadapkan dengan 

rintangan, saya ingat ketika saya 

menghadapi kendala yang sama 

sebelumnya 

3 I expect that I will do well on 

most things I try 

Saya berharap saya akan 

melakukannya dengan baik pada 

sebagian besar hal yang saya coba 

4 Other people find it easy confide 

in me 

Teman merasa mudah untuk curhat 

kepada saya 

5 I find it hard to understand the 

non-verbal massages of other 

people 

Saya merasa sulit untuk memahami 

pesan dengan bahasa isyarat orang 

lain 

6 Some of the major events of my 

life have led me to re-evaluate 

what is important and not 

important 

Beberapa peristiwa besar dalam hidup 

saya telah membawa saya untuk 

mengevaluasi kembali apa yang 

penting dan tidak penting 
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7 When my mood changes, I see 

new possibilities 

Ketika suasana hati saya berubah, 

saya melihat kemungkinan-

kemungkinan baru 

8 Emotions are one of the things 

that make my life worth living 

Emosi adalah satu hal yang membuat 

hidup saya berharga 

9 I am aware of my emotions as I 

experience them 

Saya sadar emosi saya karena saya 

mengalaminya 

10 I expect good things to hapen Saya mengharapkan hal-hal baik 

terjadi 

11 I like to share my emotions with 

others 

Saya ingin berbagi ide dengan teman 

yang lain 

12 When I experience a positive 

emotion, I know how to make it 

last 

Ketika saya mengalami emosi positif, 

saya tahu bagaimana membuatnya 

berakhir 

13 A arrange events others enjoy Saya suka mengatur acara, teman lain 

tinggal menikmati 

14 I seek out activities that make me 

happy 

Saya mencari kegiatan yang membuat 

saya bahagia 

15 I am aware of the non-verbal 

massages I send to others 

Saya sadar pesan dengan gerak isyarat 

yang saya kirim kepada teman yang 

lain 

16 I presents myself in a way that 

makes a goog impression on 

others 

Saya menampilkan diri dengan 

memberi kesan yang baik kepada 

teman yang lain 

17 When I am in a positive mood, 

solving problems is easy for me 

Ketika saya dengan suasana hati yang 

senang, memecahkan masalah mudah 

bagi saya 

18 By looking at their facial 

expressions, I recognize the 

emoyions people are 

experiencing 

Dengan melihat ekspresi wajah 

mereka, saya mengenali emosi teman 
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19 I know mhy my emotions change Saya tahu kenapa emosi saya berubah 

20 When I am in a positive mood, I 

am able to come up with new 

ideas 

Ketika saya di suasana hati yang 

positif, saya bisa datang dengan ide-

ide baru 

21 Have control over my emotions Saya memiliki kontrol atas emosi 

saya 

22 I easy recognize my emotions as 

I experience them 

Saya dengan mudah mengenali emosi 

saya karena saya mengalaminya 

23 I motivate myself by imagining a 

good outcome to task I take on 

Saya memotivasi diri dengan 

membayangkan hasil yang baik untuk 

tugas-tugas saya 

24 I compliment others when they 

have done something well 

Saya beri pujian teman sekelas ketika 

mereka telah melakukan sesuatu 

dengan baik 

25 I am aware of the non-verbal 

massages other people send 

Saya sadar pesan dari orang lain 

dengan menggunakan bahasa isyarat 

26 When another person tells me 

about an important event in his 

or her life, I almost feel as 

though I have experienced this 

event myself 

Ketika teman bercerita tentang sebuah 

peristiwa penting dalam hidupnya, 

aku hampir merasa seolah-olah saya 

telah mengalaminya sendiri 

27 When I feel a change in 

emotions, I tend to come up with 

new ideas 

Ketika saya merasakan perubahan 

emosi, saya cenderung untuk datang 

dengan ide-ide baru 

28 When I am faced with a 

chalange, I give up because I 

believe I will fail 

Ketika saya dihadapkan dengan 

tantangan, saya menyerah karena saya 

yakin saya akan gagal 

29 I know what other people are 

feeling just by looking at them 

Aku tahu apa yang teman rasakan 

hanya dengan melihat mereka 

30 I help other people feel better 

when they are down 

Saya membantu teman sekelas merasa 

lebih baik ketika mereka gagal 
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31 I use good moods to help myself 

keep trying in the face of 

obctacles 

Saya menggunakan suasana hati yang 

baik untuk membantu diri sendiri 

terus mencoba dalam menghadapi 

rintangan 

32 I can tell how people are feeling 

by listening to the tone of their 

voice 

Saya dapat memberi tahu ketika 

teman emosi dengan mendengarkan 

nada suara mereka 

 

Setelah melakukan validasi, kemudian dilakukan uji validitas dan 

reliabilitas terlebih dahulu untuk mengetahui berapa item tes yang valid dan berapa 

nilai reliabilitas dari intrumen tersebut. 

1) Uji Validitas 

Uji validitas yang digunakan di dalam intrumen EI ini adalah uji validitas 

item tes untuk menentukan seberapa valid suatu item pertanyaan mengukur EI. Dari 

hasil yang diperoleh dengan menggunakan bantu IBM Statistical Package for the 

Social Sciences (SPSS) Statistics 22 dengan menggunakan teknik analisis 

Cronbach's alpha. Dari hasil analsis yang telah dilakukan dari 32 item tes diperoleh 

sebanyak 25 dinyatakan valid. Untuk lebih jelas dapat di lihat pada tabel di bawah 

ini. 

Tabel 3.7. 

Hasil Uji Validitas Item Tes EI 
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Nomor Item Tes r hitung r tabel Keterangan 

1 0,111 0,238 Tidak Valid 

2 0,368 0,238 Valid 

3 0,373 0,238 Valid 

4 0,278 0,238 Valid 

5 0,414 0,238 Valid 

6 0,421 0,238 Valid 

7 0,363 0,238 Valid 

8 0,144 0,238 Tidak Valid 

9 0,469 0,238 Valid 

10 0,353 0,238 Valid 

11 0,276 0,238 Valid 

12 0,372 0,238 Valid 

13 0,056 0,238 Tidak Valid 

14 0,444 0,238 Valid 

15 0,127 0,238 Tidak Valid 

16 0,285 0,238 Valid 

17 0,490 0,238 Valid 

18 0,470 0,238 Valid 

19 0,482 0,238 Valid 

20 0,344 0,238 Valid 

21 0,479 0,238 Valid 

22 0,297 0,238 Valid 

23 0,211 0,238 Tidak Valid 

24 0,444 0,238 Valid 

25 0,435 0,238 Valid 

26 0,443 0,238 Valid 

27 0,480 0,238 Valid 

28 0,133 0,238 Tidak Valid 

29 0,418 0,238 Valid 

30 0,165 0,238 Tidak Valid 

31 0,338 0,238 Valid 

32 0,657 0,238 Valid 

 

1) Uji Reliabilitas 

Dari hasil uji validitas item tes yang telah dilakukan dan didapat sebanyak 

25 item tes yang valid. Kemudian 25 item tes tersebut dilakukan uji reliabilitas yang 

dianalisis dengan menggunakan bantu IBM SPSS Statistics 22 dengan 
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menggunakan teknik analisis Cronbach's alpha. Dari hasil analisis didapat nilai 

reliabilitas sebesar 0,837. Untuk lebih jelas dapat di lihat pada tabel di bawah ini. 

Tabel 3.8. 

Hasil Uji Reliabilitas EI 

Cronbach's Alpha N of Items 

0,837 25 

 

3.4.2 Keterampilan Bermain Bolabasket 

Instrumen di dalam penelitian ini dengan menggunakan Basketball 

Offensive Game Performance Instrument (BOGPI), tata cara penggunaan 

instrumen dengan bermain 2 X 10 menit 3 vs 3. Instrumen tersebut memilki 

interrater reliability sebesar 99% dan alpha reliability coefficient untuk skala total 

sebesar 0,95 (Chen, Hendricks, & Zhu, 2016).  

 

3.5 Prosedur Penelitian 

Prosedur penelitian yang akan dipaparkan disini adalah bagaiman langkah-

langkah yang digunakan peneliti dalam penyususnan penelitian yang akan 

dilakukan. Langkah-langkah yang akan ditempuh di dalam penelitian ini adalah 

sebagai berikut: 

1) Pembuatan rancangan penelitian. 

Dalam tahap ini langkah-langkah yang diambil berkaitan dengan menyusun 

proposal penelitian yang terdiri dari: memilih masalah penelitian, pendahuluan 

yang dituangkan ke dalam latar belakang, perumusan masalah penelitian sesuai 

dengan latar belakang, tujuan penelitian, perumusan kerangka pemikiran dan 

hipotesis, pemilihan metode penelitian, menentukan sumber data, perancangan 

instrumen penelitian, dan teknik yang digunakan dalam analisis data untuk menguji 

hipotesis penelitian. 

2) Pelaksanaan penelitian 

Dalam tahap ini langkah–langkah yang diambil merupakan proses sebelum 

memasuki kegiatan penelitian di lapangan dan pengumpulan data yang akan 

digunakan sesuai dengan instrumen yang akan digunakan. Langkah-langkah yang 

dilalui terdiri dari: bimbingan kepada promotor, kopromotor, dan anggota, 
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penyusunan kembali instrumen penelitian agar dapat memenuhi kriteria instrumen 

yang baik dengan adanya validitas dan reliabilitas yang memenuhi syarat, 

pengumpulan data dengan menggunakan instrumen yang telah diuji validitas dan 

reliabilitasnya, analisis data sesuai dengan uji hipotesis yang telah diajukan, dan 

membuat kesimpulan dari hasil penelitian yang telah diperoleh. Untuk lebih 

jelasnya langkah-langkah yang akan ditempuh dalam penelitian ini dapat dilihat 

pada gambar berikut ini: 

 

 

  Populasi    

     

  Tes EI (tinggi dan rendah)   

     

  Sampel    

     

Kelas Eksperimen 

(Hybrid SE-IGCM) 

 Kelas Kontrol 

(Sport Education Model) 

     

Keterampilan Bermain 

(Post-Test) 

 Keterampilan Bermain  

(Post-Test) 

     

  Pengolahan dan Analisis 

Data 

  

     

  Kesimpulan    

 

Gambar 3.2. 

Langkah-Langkah Pengumpulan Data 

3) Pembuatan laporan penelitian 

Pada tahap ini peneliti menulis laporan sesuai dengan data yang telah 

didapatkan selama proses penelitian. 

3.6 Analisis Data 

Di dalam penelitian ini menggunakan siswa sebagai subjek penelitian atau 

disebut dengan partisipan, patisipan dalam penelitian ini adalah calon guru 

pendidikan jasmani. Data yang akan di analisis dalam penelitian ini adalah hasil 

dari penggunaan instrumen penelitian yang telah dipaparkan di atas. Berikut teknik 

yang digunakan dalam penganalisisan data: 
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3.6.1 Rata-Rata, Simpangan Baku, dan Varian 

Untuk perhitungan rata-rata, simpangan baku, dan varian dengan 

menggunakan aplikasi IBM Statistical Package for the Social Sciences (SPSS) 

Statistics 22. Tahapan penghitungan yang akan dilakukan dengan langkah-langkah 

sebagai berikut: klik Analyze > Descriptive Statistics > Descriptives > Masukan 

semua variabel ke kotak Variable(s) > Options > ceklis Mean, Std. Deviation, dan 

variance > Continue > OK. 

3.6.2 Uji Normalitas 

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui 

apakah data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan 

shapiro-wilk atau kolmogorov-smirnov dengan bantuan IBM Statistical Package 

for the Social Sciences (SPSS) Statistics 22. Tahapan penghitungan yang akan 

dilakukan dengan langkah-langkah sebagai berikut: klik Analyze > Descriptive 

Statistics > Descriptives > Explore > Masukan semua variabel ke kotak Dependent 

List > Plots > ceklis Normality plots with tests > Continue > OK. Format 

pengujiannya dengan membandingkan nilai probabilitas (p) atau signifikansi (Sig.) 

dengan derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai berikut: 

1) Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan normal. 

2) Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak normal. 

3.6.3 Uji Homogenitas 

Uji homogenitas digunakan untuk mengetahui apakah suatu data atau 

sampel yang diambil berasal dari varian yang homogen atau tidak. Uji homogenitas 

dilakukan sebagai prasyarat dalam uji ANOVA. Uji homogenitas menggunakan 

Lavene Statistic dengan bantuan IBM Statistical Package for the Social Sciences 

(SPSS) Statistics 22. Tahapan penghitungan yang akan dilakukan dengan langkah-

langkah sebagai berikut: klik Analyze > Compare Means > One-Way ANOVA > 

Masukan variabel ke kotak Dependent List > Masukan faktor ke kotak Factor > 

Options > Homogenity of variance test > Continue > OK. Format pengujiannya 

dengan membandingkan nilai probabilitas (p) atau signifikansi (Sig.) dengan 

derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai berikut: 

1) Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan homogen. 

2) Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak homogen. 
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3.6.4 Uji Hipotesis 

Uji hipotesis yang digunakan dalam penelitian ini menggunakan uji 

ANOVA dengan bantuan IBM Statistical Package for the Social Sciences (SPSS) 

Statistics 22. Tahapan penghitungan yang akan dilakukan dengan langkah-langkah 

sebagai berikut: 

Buka Tab Variable View: Buat 3 variabel dengan ketentuan sebagai berikut:  

1) Variabel independen: 1. "SE" dengan kategori Hybrid SE-IGCM dan SEM. 

Measure = Nominal, Decimals = 0, Type = Numeric, dan isi Values: 1 = Tim, 

2 = Individu. 

2) Variabel independen: 2. "EI" dengan kategori tinggi dan rendah. Measure = 

Nominal, Decimals = 0, Type = Numeric, dan isi Values: 1 = Tinggi, 2 = 

Rendah. 

3) Variabel dependen: "keterampilan bermain". Measure = Scale, Decimals = 0, 

Type = Numeric, 

Setelah langkah-langkah di atas lalu klik Analyze > General Linear Model 

> Multivariate > Masukan data aktivitas fisik dan kompetitif ke ke kotak Dependent 

Variable, masukan SEM dan EI ke kotak Fixed factor(s) > klik Plot masukkan 

SEM  ke kotak Horizontal Axis dan EI  ke kotak Separate Lines > add > continue 

> klik Post Hoc, masukkan SEM dan EI ke kotak Post Hoc Test for > Tukey > 

continue > klik Options > Desriptive statistics > Estimates of effect size > 

Homogeneity tests > continue > klik OK. Uji kebermaknaannya sebagai berikut: 

1) SEM: Pengaruh SE terhadap keterampilan bermain. Apabila Signifikansi 

(Sig.) <0,05 (Alfa)= Signifikan. 

2) EI: Pengaruh EI terhadap keterampilan bermain. Apabila Signifikansi (Sig.) < 

0,05 (Alfa)= Signifikan.  

3) SE*EI: Pengaruh kemampuan SE*EI terhadap data keterampilan 

bermain. Apabila Signifikansi (Sig.) <0,05 (Alfa)= Signifikan. 

4) Error: Nilai Error model, semakin kecil maka model semakin baik. 

Dengan demikian berdasarkan tata cara perhitungan hipotesis statistik di 

atas yang diajukan dalam penelitian ini adalah sebagai berikut:  

1) Ho : µA1   = µA2 

Hi  : µA1   > µA2 
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2) Ho : Interaksi A x B = µA2 

Hi  : Interaksi A x B ≠ µA2 

3) Ho : µA1B1  = µA2B1 

Hi  : µA1B1  > µA2B1 

4) Ho : µA1B2  = µA2B2 

Hi  : µA1B2  > µA2B2 

Keterangan: 

µA1 : Rata-rata keterampilan bermain bolabasket kelompok siswa dengan 

Hybrid SE-IGCM. 

µA2 : Rata-rata keterampilan bermain bolabasket kelompok siswa dengan 

Sport Education Model. 

µA1B1 : Rata-rata keterampilan bermain bolabasketkelompok siswa yang 

memiliki emotional intelligence tinggi dengan Hybrid SE-IGCM. 

µA2B1 : Rata-rata keterampilan bermain bolabasket siswa yang memiliki 

emotional intelligence tinggi dengan Sport Education Model. 

µA1B2 : Rata-rata keterampilan bermain kelompok bolabasket siswa yang 

memiliki emotional intelligence rendah dengan Hybrid SE-IGCM. 

µA2B2   : Rata-rata keterampilan bermain bolabasket kelompok siswa yang 

memiliki emotional intelligence rendah dengan Sport Education 

Model. 
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